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Now that you have installed ATS, you are ready to begin using the system. This brief Quick Start
Overview and the following User Manual provide the general information needed to begin entering
data into the system and using ATS for the first time.

ASSET TYPES AND CLASSIFICATIONS

This function allows you to create classifications and types within each classification. Classifications (i.e.
Office Equipment) and (sub-) Types (i.e. Desks, Chairs, etc.) are used to categorize assets. On the menu
bar select Support = Asset Support Administration. You can rename the Classifications and Types
designators in the Setup Options function if desired. See Asset Support Administration in the User
Manual for more information.

CONDITIONS

Add any number of Conditions that you desire (Excellent, Good, Poor, etc.) This is a searchable field
and can be invaluable to locate equipment needing replacement, etc. See Support—> Condition
Administration for additional information.

FUNDING SOURCE AND ACCOUNTS

The Funding Source is a standalone field that can be setup by you to use as needed. You can also
rename the Funding Source in the Setup Options function if desired. The Accounts screen allows you to
tie each Asset to an account number for added filtering. See Support—=>Funding Source Administration
and Account Administration for more information.

FACILITIES

This function allows you to enter facilities, which are used to organize asset locations. On the menu bar
select Support->Facility Administration. See Facility Administration in the User Manual for a detailed
explanation.

LOCATIONS

This function allows the user to create locations where assets are stored or to which assets are checked
out. Locations can also be classified as “Storage” locations. Storage locations are typically where
materials are centrally located until checkout. On the menu bar select Support—=> Location
Administration. See Location Administration in the User Manual for a detailed explanation.

EMPLOYEES

This function has you enter employees. An employee may be an individual that will be using the ATS
system or a person to which assets may be checked out. You can set ATS Access Rights for each
employee here also. On the menu bar select File->Employee Administration. See Employee
Administration in the User Manual for a detailed explanation.
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PRINTER ASSIGNMENT

This function allows the user to specify which windows printer will be used for report printing. This
function must be set on each workstation before printing. On the menu bar select File>Printer
Assignment. See Printer Assignment in the User Manual for a detailed explanation.

ASSETS

The asset administration screen allows for the creation and history of assets which are tracked by this
system. On the main button bar select the Asset button. See Asset Management in the User Manual
for a detailed explanation.

Once you have setup your initial data, you are ready to start using ATS! Check out assets to employees
or locations. You can also check assets back “in” to storage. Be diligent on how you use the system and
it will provide years of reliable tracking of all of your assets!

Backup your database daily!
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i " Upon opening the program, the screen at left will appear.

Log In You will be prompted to enter a User Name and Password.
If it is the first time logging in, you will use the Admin
Enter your user name and password to log in. User’s data:
User Name: | Username: ADMIN
P Password: ADMINUSER

‘ 'ﬂj i ‘ Other users may be added to the system after setup. After
users are entered into the system, they should each log in
under their own User Name and Password.

‘ "ﬁ, Log In

Registration g After logging in as Admin, click File on the menu and select
Registered Owner License Registration Form. This step is important because it assigns
Customer DENT: [ licensing rights to you. Entering the information will unlock

the program for your licensed use.

License Key: | | | |

The Four Digit Customer Identifier and the 16 digit License
Key will be provided by Gigatrak when the product is
purchased.

l Clear ll Register ll Cancel |

After registering your product, click File on the menu and select Setup Options. (Setup Options can only
be accessed when logged in as Admin.)

This option can be used to change the names of the parameters to fit your needs. This makes up the
structure of the system.
7 setp Optiome \é’

Setup Options

Edition
& Staen ¢ Basic © Pro C Schoal ﬁ OK

_ Classification, Type, Facility, Location, and
Asset Setup (F1) | " Application Settings (F2)

e Funding Source are parameters tied to
Rename Classification: |Classification

i) assets. Model Number, Serial Number, and
Rename Facility: [Faciity

Rename Location: [Locaton Condition can be renamed to suit your
Rename Funding Source: [Funding Sowce
Rename Model Number: [Product Number nGEdS.
Rename Serial Number: [Serial Number
Rename Condition: [Cordton If you would like to alter any of the names,

Raot Image Folder. G UserstAsnynRBocure [1o]  Report Ao E-mail Setup type in the desired value and then click the
Root Document Folder [ [.] SMTPHost [
CustomRopart Foder: [ [ From E-mail Address: [ OK button.

o — ,7@ SMTP User Name:
aport Logo:
gigatek P SWTPPassword [

Use SSLTLS: [
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The root image folder is the default location for images that you wish to tie to an asset. If the image is
in the default location, only the file name is required in the asset screen to identify the image.

The Custom Report Folder is the location for custom report files. If a custom report is ordered, the
report file should be placed in a folder, and the path to the folder should be set in this option.

The Report Logo allows the display of a company logo on reports. You can select a .bmp, .gif, or .jpg file.
To clear a logo after it is selected, click the “Select” button and click Cancel on the selection screen.

Application Settings control various functions in the asset tracking application.

[ setup Options

=

Setup Options
Edition
@ Starter " Basic (" Pro ¢ School

Asset Setup (F1)

I Show Depreciation
F Allow Delete Asset & Purge History
I Relocate Assets (vs. Check In/Out)
I Aute-populate Asset Find tab

¥ Display Employee Barcodes before names

-

F# Display Account Numbers before descriptions

ﬁOK

Application Settings (F2)

Preferred Depreciation Type- \uwg
(MACRS: Modified Accelerated Cost Recovery System)

I~ Show Bin Assets Below Reorder Point Report after Log in

El

SHOW DEPRECIATION

[% setup oOpti
Setup O

Edition
" Starf

¥ Sho

W Allow]
W Relo
™ Auto-|
¥ Displ;
I Displ

I~ Sho

& Depreciation Disclaimer

Depreciation Disclaimer

[This Depreciation Function, including access to formulas used for the computations provided
hersin, is provided by GigaTrak solely for your canvenience and for illustration purposes anly.
GigaTrak is not licensed or qualified to give, and is not providing to you, any legal, tax,
financial reporting or accounting advice. GigaTrak dues not guaranty the accuracy of

the computations. Furthermore, GigaTrak can not be aware of any customer's particular
circumstances and GigaTrak does not purport to keep up to date with any tax, financial
reporting or standards or _The contained herein is

not guaranteed to be comect, complete or up to date. Accordingly, you should consult

with your own legal, tax, financial reporting and accounting advisors. GigaTrak is

not responsible for any loss, injury, claim, liability or damage related to your use of this
Depraciation Function or the output hereof and by your use of this Depraciation Function
you waive and release GigaTrak fram any such loss, injury, claim, liability or damage

You use this Depreciation Function at your own risk and the comectness and usability

of the output hereof remains your sole responsibility.

GigaTrak is not licensed or qualified to give, and is not providing to you, any legal, tax,
financial reporting or accounting advice

" | agree to the terms of this disclaimer

| do not agree to the terms of this disclaimer

If Show Depreciation is checked, then the
depreciation information will be visible on the
Asset information screen. The Asset
Depreciation Report will also be available on
the Reports screen. If the checkbox is not
checked, the depreciation information will not
be visible and the depreciation report will not
be shown.

The checkbox cannot be checked until you
accept the disclaimer.

After accepting the disclaimer, the Preferred

Depreciation Type selection will be enabled. This will be the default selection when adding new assets

on the Asset Information screen.

velz
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ALLOW DELETE ASSET & PURGE HISTORY

If checked, then the Delete button will be displayed on the Assets screen, and the Purge History button
will be displayed on the Asset History screen. If the checkbox is not checked, the Delete button and the
Purge buttons will not be displayed.

RELOCATE ASSETS

If Relocate Assets is checked, the Check In/Out function will change to a relocate function. This option
does not use storage locations and does not allow entry or tracking of binned items. Assets are
relocated from one location (or person) to another location (or person) without being returned to a
storage location.

AUTO-POPULATE ASSET FIND TABS

When checked, the system will automatically display information when a Find screen is opened. If not
checked, you must first click “Extract Data” to view a listing.

DISPLAY EMPLOYEE BARCODES BEFORE NAMES

This applies to several report selection filters. If you view employees primarily by their names, leave
this unchecked. If you prefer tracking employees by the Barcode ID, then check the checkbox.

DISPLAY ACCOUNT NUMBERS BEFORE DESCRIPTIONS

The same rules apply to this option. Select how you prefer to view your report filters here. If you will
view accounts by descriptions, leave this unchecked. If you prefer tracking accounts by numbers, check
the box.

SHOW BIN ASSETS BELOW REORDER POINT REPORT AFTER LOG IN

By selecting this option, the system will automatically display the report of any binned items below the
reorder point immediately following log in.

REQUIRE CHECK IN BEFORE ANOTHER CHECK OUT

Checking this box will require a checked out asset to be checked back in to the storage location before
it can be checked out again. Leaving this unchecked will allow an asset to be checked out from person
to person (or location to location) without being returned to the storage location.

To save the changes for both tabs on the screen, select the OK button. A confirmation message will
appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen.
Selecting “No” will reset the changes back to the original values.

To leave the screen without changing any values, select the in the upper right corner of the
screen.
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Employees are either people that have access to the ATS system or people to whom assets will be
assigned. To manage employees, select Employee Administration under the File menu.

® Employee Administration @ ..
— Upon initial setup, the only employee
Employee Administration i b h Ad . v Add
will be the Admin user. You ma
l% Add] I//‘ Edill [%( Delele‘ ) ] Y ) !
- Edit, or Delete employee information.
Employee: | I > Export To File ID Print Barcode List |
To Add a new employee, select the Add
Name Barcode Active? i
Dne,Maw button. The form will change as
Jones, Sean E005 Yes
Ovien, Mies EQ Yes indicated. The items in bold text are
Smith, John E001 Yes
User, Admin Yes H
g - = required for all employees.

The system will not allow editing of the
last name, first name, middle initial, or
user name for Admin User.

To delete an employee, select the
employee and then select the delete
button.

6 rows found

If an employee is assigned an asset or has an outstanding reservation or is involved in a history record,
the system will not allow the employee to be deleted. Set the Status to inactive to prevent further use.

Enter the appropriate employee information. A few fields have special requirements:

(;ﬂ Employee Administration

Employee Administration

Employee Info

Firsmame: |

Last Name: |

Middle Initial:

Barcode: |

Log in Name:

(Min. 5 characters)

Password:

(Min. 5 characters)

Phone: |

Alt. Phone: |

E-mail: |

MNotes:

velz
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The barcode entry must be unique. A barcode for an asset,
location, or employee cannot be the same. Keep the barcode
as simple as possible, only using a short combination of
capital letters and numbers. If you use the supplied barcode
labels, the employee's barcode must match the label placed
on their badge.

If the employee will be using the ATS system, he will require
a Log in Name and Password.

The Log in Name must be between 5 and 10 characters long.
It must be unique; no two employees may have the same log
in name. Log in names are not case sensitive.

MANUAL- STARTER EDITION 10



A password must be between 5 and 10 characters long. Passwords are not case sensitive.

EMPLOYEE ACCESS LEVELS

Once the employee information is entered, set the employee's access levels. The default access level is
for no access to ATS.

. Ervplyee Adrinstaton lEsl Asset Administration - applies to
Sy iRkl el activities associated with creating and
@ coma| editing asset data.
Employee Info Access Levels
Fiat s R Asset Check In/Check Out- applies to
LastHame: £t Ve G B activities associated with assigning
Widde il [ assets to an individual or location, or
Parnd| returning assets to storage.
Ulngg; 'ffi’i{:/‘ Asse; CNhneck In/ Check Out -
(Min. § characters)
Phone:| Asset Support Administation Asset Support Administration - applies
A Phone:| te e o to activities that support the overall
E-mail: | Employee Administration

asset process. This will include

Notes: i ® No " View " Edit
¢ managing facilities, locations, asset types,
-
: classifications, and conditions.

To repairicompact the database, click the Compact Database button.

Employee Administration— applies to activities associated

with managing employee information.

To save the employee information, including the access
level changes, select the Save button. Selecting the Cancel button will leave the present process
without saving the employee information.

If you have the Access version of ATS, this option is used to periodically repair, compact, and backup the
ATS database. To determine if you have the Access version of ATS, go to the Help tab—>About and the
header of the box will say “About (Access)”

It is possible that the Access database can get corrupted. Compacting the database may repair the
damage. In addition, a previous compact operation will have created a backup of the database that can
be used if the current database is corrupted beyond repair.

The system will retain three backup copies of the database in the dbbackup folder. Backing up
frequently will minimize the loss of data if the current database is corrupted beyond repair.
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MS Access does not automatically remove data that is deleted by
the system. Compacting the database will remove data that has
been deleted. This will reduce the size of the database file and
improve performance.

To compact the database, select Compact Database under the File
menu. Then select the Compact Database button.

The system will compact, repair, and backup the database and
when complete, the Compact Database screen will disappear.

i Change Password &

Change Password

Enter current User Name and Password.
Then follow the on-screen instructions.

Enter New Password:
Change Password

A user currently logged into ATS may change their password at any time. Select Change Password from

the File menu and the screen at left appears.

Type in your current user name and password and then select the Change password button.

Passwords must be between 5 and 10 characters long.

% Log In Temporarily

Type in your new password and then select the Change
Password button.

Type in your new password again. If the password matches
the new password you typed earlier, the system will save the
new password and the Change Password screen will
disappear.

Log In Temporarily

Enter your user name and password to temporarily login.

User Name: |

Password: |

‘_/ﬁ Login

If the password does not match the password typed in earlier,

the system will state the passwords do not match and ask if you wish to try again.

If you answer yes, the screen will be returned to the state above and you may try to type the second

password again.

# Change Password =

Change Passwordlﬂ\)

Enter current User Name and Password.
Then follow the on-screen instructions.

User Name:
Password:

Change Password

the Log In button.

Log in temporarily is a function used in order to perform some
function that the current user may not complete without the
current user having to exit the program.

Select Log In Temporarily under the file menu. The screen at right
will appear. Enter your user name and password, and then select
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The banner on the main screen will turn red. As long as someone is temporarily logged into the system
these conditions will remain.

When the user temporarily logged in logs out by selecting the Log Out button, the main screen will
return to normal and the original user is the current user.

If you would like to purge all history before a certain date, you can enter a specific date and then click
OK. WARNING!! Be very careful with this feature, when you click OK, all asset history records will be
purged for good.

Enter Date =
All toal history records prior to this date will be purged. 0K
Please enter a date: e
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% Each import has specific instructions included on
the import screen that delineates data formatting
requirements along with any special instructions

Ll Import Employees

Import Employees

This import['s Tor NEW employees only.

It does NOT update existing employee records. you may need. Imports are available for the

The column layout of the expected import file is as follows: fOHOWing:

*Mame, *Barcode, *Facility, Log in Name, Password, Phone, Alt. Phone,

E-mail, Notes, Master Access, Tool Access, Check In / Out Access, . : :
Transfer Access, Resenvation Access, Member Access, Employee Access, Import Assets: Allows the import of asset data into
Tool Status Access, Support Access, Maintenance Access, Status the ATS system.

- The file format is TXT (Tab delimited).

- The layout will be based on column position, not column headers.

- A column header row, if detected (based on the words BAR CODE or Import Employees: Allows the import of employee

Print Instructions data into the Employee Administration table. The

File: : P £

e import even allows for the granting of specific

= S
Find File access rights to the various functions in ATS.

' Backup the database . . .
!\ (File menu) before Import Locations: Allows the import of location

‘ 3=/ ImportFil importing new data data into the ATS system

o View
&+ Log File

After logging in, select Check for Update on the Help menu. Major updates may require you to contact
GigaTrak and receive a special download. Access to the Check for Update function is only available
when the ADMIN login is used. You must have a current Support Agreement in place to download

updates.

The “About” section tells you which version of the software you currently have as well as some brief
licensing information. This area also specifies which database the software uses for your system. This
section is particularly helpful to the support and training teams when working to assist you on any

guestions you may have regarding the ATS system.
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ACCOUNT ADMINISTRATION

Account Administration is used to keep track of the account numbers that are used to purchase assets.

Account numbers are not required to use ATS.

¥ Account Administration

Account Administration
ll:{'.,-:l Add l l/ Edit l ’% Delete

Account Number: |1000

Description |ﬁ~.ccoummg Department

o @)
Account Number Description Active?
2000 Marketing Department Yes
3000 Maintenance Department Yes
4000 Administration Department Yes

To begin the process, select
Account Administration from the
Support menu.

To Add a new account, select the
Add button. Enter the Account
Number (required field) and a
description (optional), then select
the Save button.

To Edit an Account, select the
Account of interest and then select
the Edit button. Modify the
information as desired. Select the
Save button to save the Account
changes.

To Delete an Account, select the
Account to be deleted and then

select the Delete button. The system will check to see if the account is tied to an asset. If so, the
system will not allow the Account to be deleted. You may inactivate the Account to prevent it from

being assigned to an asset in the future if you desire.

ASSET CONDITION ADMINISTRATION

Assets may be assigned a Condition, which indicates the usefulness of the asset. To access this process,

select Condition Administration under the Support menu.

Each Condition has a name and Description. In addition a Condition may be designated as Active or

Inactive.

e Condition name may be up to 20 characters and is required. This name must be unique.
e Description may be up to 80 characters long and is not required
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& Asset Condition Administration =

Asset Condition Administration

‘% Add ‘ ‘L// Edit ‘ ‘%Delete

Condition: |Exce|lent

Description |f‘lew or nearly new
ol o~
Condition Description Active?
Good minimal damage Yes
MNeeds Repair ltem needs maintenance Yes
Poor Damage with functionality problems Yes

A Condition set as active may be assigned
to an asset; a Condition set as inactive will
not be available for assignment to an
asset. Setting a condition as “inactive”
minimizes clutter, but retains historical
information tied to each condition.

To add a new Condition, select the “add”
button, enter the new Condition (name)

and Description, and click “save” button

to save the new condition.

To edit an existing Condition, select the
Condition to be edited and then select
the Edit button. Modify the Condition
(name), Description, or Status (Active vs.
Inactive). Select the Save button to save
the changed Condition.

To delete a Condition, select the Condition to be deleted and then select the Delete button. The
system will check to see if the Condition is assigned to an asset. If so, the system will not allow the
Condition to be deleted. You may inactivate the Condition to prevent it from being assigned to future

assets if you desire.

ASSET SUPPORT ADMINISTRATION

Asset Support Administration is used to administer Classifications and Types. To access this process,
select Asset Support Administration under the Support menu. Asset Support Administration has two

tabs: Classification and Type.

CLASSIFICATION

[Z Asset Support Administration ==

Asset Support Administration

Add Edit % Delet Print List
g e | [ 2 e | ow | [ & priociia

Classification (F1) T Type (F2)

Classification: [Electronics
Description
(ol (o
Classification Description Active?
. lves |

Furniturs Yes

velz

The first tab is Classification. Assets may
be assigned a Classification to organize
them in groups.

Each Classification has a name
(Classification) and Description. In
addition, a Classification may be
designated as Active or Inactive. A
classification assigned as active may be
tied to an asset; an inactive classification
may not be tied to an asset.

ATS USER MANUAL- STARTER EDITION 16



A classification may be set as inactive to reduce clutter yet retain important historical information.
o (Classification (name) may be up to 20 characters and is required. The Classification (name) must
be unique (i.e., no other Classifications may have the same Classification (name)).
e Description may be up to 80 characters long and is not required.

To add a new Classification, select the Add button. Enter the new Classification (name) and Description
(optional). Select the Save button to save the new Classification.

To edit an existing Classification, select the Classification to be edited from the listing and then select
the Edit button. Modify the Classification (name), Description, or Status (Active vs. Inactive). Select the
Save button to save the changed Classification.

To delete a Classification, select the Classification to be deleted and then select the Delete button. The
system will check to see if the Classification is assigned to an asset. If so, the system will not allow the

Classification to be deleted. You may inactivate the Classification to prevent it from being assigned to

future assets if you desire.

To leave the process, select the [XI in the upper right corner of the screen.

TYPE

The second tab is type. Type is a subclass of Classification. Each Classification can have several Types.
In addition to grouping assets under a Type, the Type will also set the default depreciation period for
assets assigned to it.

Each Type has a name (Type), Description, and Depreciation period in years. In addition a Type may be
designated as Active or Inactive. A Type set as active may be assigned to an asset; a Type set as
inactive will not be available to be assigned to an asset.

A type may be set as inactive to reduce clutter, yet retain important historical information.

[ TR = e Type (name) may be up to 20
Asset Support Administration characters and is required. The Type (name)
\.%: add |/ Edit \ \S@ Delete |© Print List must be unique (i.e., no other Types may have
Classification (F1) Type (F2) the same Type (name)).
Gl e Description may be up to 80
Type: [Compater |

characters long and is not required.

Description:

To add a new Type, select the Add button.

— — . . e Select the appropriate Classification for the
computer | |ves |

= - new Type. Enter the new Type (name), and
Printer Yes

Projector ves Description. Select the Save button to save

the new Type.

To edit an existing Type, select the Type to be
edited and then select the Edit button.
Modify the Type (name), Description, or Status (Active vs. Inactive). Select the Save button to save the
changed Type.
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To delete a type, select the Type to be deleted and then select the Delete button. The system will

check to see if the Type is assigned to an asset. If so, the system will not allow the Type to be deleted.

You may inactivate the type to prevent it from being assigned to future assets if you desire.

To leave the process, select the [X] in the upper right corner of the screen.

Facilities are the upper hierarchy of locations. In other words, locations are tied to a facility. Due to

this structure, at least one facility is required by the system.

B Facility Administration 23

Facility Administration

ll::-—-::;l Add ] L// Edit l l% Delete

F%cilily
Facility Name Active?

Main School Yes

Support menu.

To Add a new
facility, select the
Add button. Enter
the information as

Save button to save the new Facility.

desired. Select the

To Edit a Facility, select the Facility of interest and then
select the Edit button. Modify the information as desired.

Select the Save button to save the Fa

cility changes.

To delete a Facility, select the Facility to be deleted and
then select the Delete button. The system will check to see

if a location is tied to the Facility. If s
allow the Facility to be deleted. You
Facility to prevent a location from be
the future if you desire.

velz

o, the system will not
may inactivate the
ing assigned to it in
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To begin the process, select Facility Administration from the

Facility information consists of:
e Unique Name- up to 40 characters and is required.
e Address - up to 40 characters long, but is not required.
e City- up to 40 characters long, but is not required.
e State-up to 2 characters long, but is not required.
e Zip Code- up to 10 characters long, but is not required.
e Notes-up to 255 characters long, but is not required.

hj Facility Administration

Facility Administration

l Iﬂ Save ’@Canc&l
LT ERIACME Central Warehouse|

Address:

442 Central Circle

City: |Eve rywhere

State: |WI
Zip: [55444

Notes: »

Status

@ Active ¢ Inactive

18



Funding Source Administration is used to keep track of the agency that provided the asset. The Funding
Source is not required to use ATS.

- Funding Source Administration @

To begin the process, select Funding Source Administration from
the Support Menu. The screen will appear.

Funding Source Administration

] (L] (Ko

Funding Source

To add a new Funding Source, select the Add button. Enter the
description, then select the Save button.

|Capital Budget

- - To Edit a Funding Source, select the Funding Source of interest
S Active? and then select the Edit button. Modify the information as desired.
Capital Budget .
Operating Budget Yes Select the save button to Save the Funding Source changes.

To delete a Funding Source, select the Funding Source to be
deleted and then select the Delete button. The system will check
to see if the Funding Source is tied to an asset. If so, the system
will not allow the Funding Source to be deleted. You may
inactivate the Funding Source to prevent it from being assigned to
an asset in the future if you desire.

Location Administration is used to manage the locations to which assets may be assigned. It displays all
the locations that exist in the system that are tied to the facility selected.

=6 Location Administration [=]

To add a new Location, select the Facility to
which it is to be added and then select the Add

Location Administration

) (7] Ko

button.
’ 3 Export To File S" C"”"?:d::‘i*jﬁgl“s“"“ ’O Print Barcode List
Y o Orce g Enter the location information as desired:
Location Barcode Responsible Individual  Storage?  Active? oy .ope
once o S —— e Facility - defaults to the facility selected
2l g e —— on the main form but may be changed.
Storage L005 User, Admin - Yes Yes

e Location - may be up to 50 characters
and is required. Must be unique to each
location.

e Barcode - may be up to 20 characters
long and is required. A barcode for an asset,
location, or employee cannot be the same.

e Checkout/Usage Location -location that assets can be checked out to.
e Storage Location - location used for storage rather than usage.
e Transfer Location - location that assets transfer to.

5 rows found
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=& Location Administation =]

e Responsible Individual - employee that is
responsible for the assets at the location. This is not

Location Administration

LEJUE. required. If the responsible individual is not in the
focky [lancmee 7| [ Meenrocmy system, you may go directly to the Employee
toater: 0 Administration process by selecting the Add New
S _ Employee button.
EE— e Notes - may be up to 255 characters long and
Resporsbi i . is not required.

Y= a— R P P—
e ' To edit a Location, select the Facility containing the
Location, select the Location of interest and then
select the Edit button. Modify the information as
B desired. Select the Save button to save the Location

changes.

To delete a Location, select the Location to be deleted and then select the Delete button. The system
will check to see if an asset is tied to the location or the Location is being used in a history record. If so,
the system will not allow the Location to be deleted. You may inactivate the Location to prevent an
asset from being assigned to the Location in the future if you desire.

EXPORT LIST TO FILE

This button will export information for the displayed locations to a tab delimited text file.

CHANGE RESPONSIBLE INDIVIDUAL

Change Responsible Individual will change the responsible individual for all selected locations on the
screen. Display and select the locations that you want to change. To select multiple locations, do one
of the following:

e Drag the mouse over the locations desired while holding down the left mouse button.

o Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

e Hold down the Control (Ctrl) key and select the locations you wish to change by left clicking on
each one with the mouse.

After the locations are selected, click the Change Responsible Individual button. A screen will appear
where you can select a new Employee. Select the new Employee and click the OK button.
PRINT BARCODE LIST

Print Barcode List will print a list of the displayed location barcodes that can be used for scanning.
When the Print Barcode List button is selected, a pop-up window will appear where you can set the
barcode row height. This allows you to control the space between barcodes on the list. The minimum
row height is 0.5 inch.
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The Asset Management process is started by selecting the Assets button on the main toolbar, which
displays the screen below:

Three tabs are displayed. The first is the “Find” tab, which is used to view assets and print lists of assets.
The tab is controlled by sections on the upper part of the form, allowing you to filter and view those

items by:

bt e | e Facility
e Location
e Funding Source
e Account

Search by Criteria
e (lassification

o Type
e Condition
e Status

Several key aspects are available on
the form. As an example, selecting

[ e

the Reset button will return all
selections to All. In addition, the Asset list can be sorted by one of its columns by clicking on the
heading of that column. A second click will reverse the sort order of the items in the listing.

The status of a group of selected assets can be changed all at once instead of just one asset at a time.
Select the rows in the grid of the assets you want to change. Then click the “Change Status” button. A
pop-up screen will appear where you can select the new status. Click the OK button to proceed. Note
that binned items cannot be changed to a status of Lost or Broken.

SEARCH FIELD

Groups of assets can also be displayed by typing words in the Search Description box, and then
selecting the Extract button. For example, if you type in the word “chair” into the box and click extract,
only the assets that have the word “chair” in their description will be displayed. If a location is also
selected, only assets that are located at the particular location and have the word “chair” in the
description will be displayed.

ADD TO LIST

The Add To List button can be used to build a custom list of assets. When selected, it will appear to
remain depressed. When in this mode, assets that are extracted will be added to the list of assets
already shown on the screen, rather than clearing the screen first. You can continue to change the
selection filters and extract the assets you need to build your list. The list can then be printed or
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exported. Clicking the Add To List button a second time will return the Extract Data function to its
normal mode.

PRINT LIST

To print the Assets in the list, select the Print List button. A report is displayed and if the default printer
is set, the Assets displayed on the screen will be printed when Print is selected. You may also save as a
PDF or Email the report directly.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed asset barcodes that can be used for scanning. The list
will include the Barcode number, Barcode, Description, Product Number, and Serial Number. When the
Print Barcode List button is selected, a pop-up window will appear where you can set the barcode row
height. This allows you to control the space between barcodes on the list. The minimum row height is
0.5 inch.

EXPORT LIST TO FILE

Export List To File will export information for the displayed assets to a tab delimited text file.

ASSET IMAGE

If an image is assigned to an asset, a thumbnail picture will be displayed in the Description column of
the grid. The thumbnail display can be turned on or off by right-clicking in the grid and selecting “Show
Thumbnail Images” in the pop-up menu. A larger view of the image can be displayed by selecting “View
Image” from the pop-up menu.

Selecting an Asset and then selecting the Asset Information tab, or double-clicking on an Asset will
bring up the Asset Information screen:

e Assets =
Find Asset (F1) Asset Information (F2) Asset History (F3)
Asset Information
Classification: | Electronics ~ Barcode: [A0001
Type: [Phone & Asset Number ?m
Status
Description: [XBLUE Networks X16 Corded Condiion: | Excellent -
Telephone System, Charcoal @ Active
Product Number: [794747 | N
© Retired
Serial Number. A é:"IF'
Facility: [Main Office Funding Source: | Operating Budget |~ Broken ﬁ“"
L?:::-gﬁ Account: [4000 / Administration Department _+
In Service Date: [3/12/2015 = Delele
Primary Data Purchase / Warranty Images & Docs
Copy
Binned ltem: I~

Note
Print

=
Asset
{ W S

Check Out

Location:

Date Due: Time:
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Asset information with bold text above is required. The available asset information is:

e (lassification is a method of grouping Assets

e Type is a subset of Classification and a second method of grouping Assets

e Description is up to 80 characters describing the Asset

e Facility is the building in which the Asset is located

e Storage Location is the default storage location for the Asset

e Barcode is the barcode that identifies the Asset. You must enter the first asset’s barcode number
manually in a format that all barcodes will use (i.e. AO0O001). The system will then automatically
increment the numerical portion of the barcode number one at a time. If you are using pre-printed
barcodes, enter the number seen on the barcode.

e Asset Number is the unique permanent number given to an item for tracking. An asset number is
usually engraved on larger, more expensive items.

e Condition is the physical condition of the Asset. Condition does not apply to binned items.

e Manufacturer is the manufacturer of the Asset (data entered on the Manufacturer Administration
screen)

o Model Number is the model number of the Asset

e Serial Number is the Serial Number of the Asset

e Funding Source is the agency that provided the Asset

e Account is the account number used to purchase the Asset

e In Service Date is the date the asset was put into service (defaults to current date)

e Status. An Active asset may be checked out, A Retired asset may not be checked out.

PRIMARY DATA SUB-TAB

e Note is up to 255 characters of information about the Asset

e Binned item is used for small items that cannot be individually bar coded. If the binned item
checkbox is checked, a box will appear to enter a bin quantity. There will also be an option to set the
item as a consumable. Consumable assets can be checked out, but are not expected to be checked
back in (e.g. gloves)

e Check Out determines whether an asset is checked out or not. If it is checked out, the following
information will be available

By: User to whom the asset is checked out

o Location: location to which the asset is checked out
o Due Date: date the asset is due to be checked in
o Time: time the asset is due to be checked in

PURCHASE / WARR. SUB-TAB

e Purchased From allows entry of general supplier information
e Warrant Expiration Date tracks when a warranty period expires
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e Depreciation period in years (does not apply to bin items)

o NOTE: fields relating to Depreciation will not be visible unless the “Show Depreciation”
checkbox is checked on the Setup Options screen.

e Depreciation Type. The system will calculate depreciation based on five methods: Standard Straight
Line, MACRS Half-Year, MACRS Mid-Quarter, MACRS Double Declining Half Year, and MACRS Double
Declining Mid Quarter

o MACRS means Modified Accelerated Cost Recovery System

e Original Value is the cost basis for depreciating the Asset

e Salvage Value is the remaining value of the asset after it has been fully depreciated

e Current Value is the current depreciated value of the Asset (calculated)

e Date for Current Value is the date used to calculate the current value

IMAGES & DOCS SUB-TAB

Asset Image is the path to a file that contains a picture of the asset. If the image information is entered
and a file is at the proper location, the picture will be displayed in the area to the right of the sub-tab
section. Double clicking on the image will display a full sized image of the picture. In addition, linked
documents, PDF, URLs, and other related files can be assigned to the Asset.

ADDING A NEW ASSET

To Add a new Asset, select the Add button. All information is cleared and the Save and Cancel buttons
appear.

] Assets (=)
Find Asset (F1) Asset Information (F2) Asset History (F3)
Asset Information

Classification: || - Barcode: [A0021
Type: = Asset Number

Description: Condition: -
Product Number:
Serial Number.

o Tl Tle T

. iﬁ Save
Facility: i Funding Source -
Storage ’ﬁ
Location: Account: - @ cance
In Service Date: |9/14/2015 D
Primary Data Purchase / Warranty Images & Docs
Note: Binned ltem: ™
Image
Unassigned

If turned on in System Setup, the system will automatically generate a unique barcode for the asset if
the barcode field is blank. If a specific barcode number is needed, just enter the number manually.
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Each barcode number must be unique. Select or enter the required information (bold labels). Enter
the non-required information if desired. Save the Asset by selecting the Save button. The screen will
return to the original state with the new Asset information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the information displayed that was present prior to selecting the Add button.

EDITING AN EXISTING ASSET

To Edit an existing Asset, select the Edit button. The Save and Cancel buttons appear.

Change the Asset's information as desired. Information with bold labels is required. Save the Asset by
selecting the Save button. The screen will return to the original state with the changed Asset
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

COPYING AN EXISTING ASSET’S INFORMATION TO A NEW ASSET

This is one of the most helpful features when multiples of the same type of asset needs to be entered.
To Copy an existing asset's information to use in creating a new asset, select the Copy button. The
majority of data is copied to a new record. The exception is that the barcode number, serial number
and checkout information is cleared and the Save and Cancel buttons appear.

The system will automatically generate a unique barcode for the asset. If this barcode is unacceptable,
it can be typed over by the user. The barcode entry must be unique. A barcode for an asset, location,
or employee cannot be the same. Change the asset's information as desired and add the new barcode.
Save the Asset by selecting the Save button, the screen will return to the original state with the new
Asset information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Asset information unchanged.

To Delete an existing Asset, select the Delete button. After asking if you are sure, the system will delete
the Asset.
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Selecting an asset and then selecting the Asset History tab will bring up the Asset History screen below.

| sasers

Asset History
Barcede [A0001

Descrpton: [iBLUE Hatwor
[System. Charc

Find Asset (F1)

ks X16 Corded Telephane
oal

To: [framts [

Product Number. 84747

Serial Mumber

Asset Information (F2)

oute [T [on

Py Selected
W ey

& printLia

Asset History (F3)

==

B/1/2015 1055 AWM
52172015 10:01 AM

5 11

31272015 03-33 PM

52172015 10:00 AW Che

Type
Checked in
Checked out

19PM  Relocated
M Checked in

Checkad in

AM  Checksd out
M Relocated
M Relocatsd

Hand Held Relocate
Checked out

From
Offce 102
Richards, Sally
Offce 101
Smith, Johs

n
Munrce, Connor

Munros, Connor
Ofice 202
Smith, John
Ofice 202
Smith, Joha
Ofice 101

Parsan

Flichards, Sally
Seith, John
Munroe, Connor
Munros, Connor
Smith, John

Smith. John

Location Condition | Bin Oty
Offce 101 Excellent
Offce 102 Excellert
Excellert
Office 101 Excellent

Offce 101
Offcs 202 Excallart
Excallart
Offcs 202 Excallant
Excaller
Offce 202 Excalle
Excallen
Offce 101 Excallent
Offce 101 Excallent

Chack Out Hote

Transaction By
User, Admin
User, Admin
User, Admin
User, Admin

Ussr, Admin
Ussr, Admin
Ussr, Admin
Smith, John
User Agmin

31272015 0117 PM_ Asded ew Asset Storage Excellent

User Admin

The screen displays the history of the selected asset for the date range selected. The system defaults
the date range to the last 12 months. Change one of the dates and select the Enter key or select a new
date with one of the calendar controls and the list will change to reflect the new date range.

To print the history displayed on the screen, select the Print List button.

To remove all history records for the selected asset prior to a specified date, enter the date in the Date
text box and then select the Purge button. All history records for the asset prior to the date specified
will be deleted. The purge button is only available if the “Allow Delete Asset & Purge History” checkbox
is checked on the Setup Options screen.

To leave the process, select the [XI in the upper right corner of the screen.

The Check Out process is used to check assets out to a user or location. The Check in process is used to
check assets into storage from a user or location. Check Out and Check In can also be performed on the
handheld unit. To start these processes, select the Check In/Out button.

The Check In/Check Out process is composed of three (3) tabs. The first tab is the Check Out process
as shown below.
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& CheckIn/Out =
Check Out | H Save ‘ [% Save / Print ‘ ‘ @ Reset / Clear | % Remove Item
Check Out (F1) Check In by Asset (F2) Check In by Person / Location (F3)
@ Location ¢ Employee
N T
Due Date [=) a‘:’;:;‘ Interval: Time Due:

Note: |

Asset Barcode: (] Description:

Barcode Description Due Out Condition

Person

Location

Bin Qty

Note

User Name: User, Admin

To check out assets:

e Select a Container, Location, or Employee to which the asset will be checked out

Database: Incalhostiwin_ats

e [f desired, enter the due date for the return of the Asset. Enter a date in the Due Date box, or
enter a Default Interval (humber of days from today)

e Scan the Asset barcode

e [fthe Asset is a binned item, a box will appear below the barcode to enter the quantity being

checked out

The asset checkout information will be displayed in the grid. To check out another asset to the same

location/employee and with the same due date, scan another asset barcode.

If no scanner is available, you may enter the barcode information into the barcode text boxes and then

press the enter key on the keyboard. You may also select the find button next to the textboxes to

display a list to choose from.

Items that are entered into the grid by mistake can be removed by selecting the item and clicking the

Remove Item button.

Once items are displayed in the grid, the Out Date/Time can be changed by clicking the Change Out
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for

ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired

date and time.

When all desired assets have been checked out, select the Save or Save/Print button. The check out

information will be saved and, if Save/Print was selected, the system will ask if you wish to print the

check-out report. The system will then clear the check-out list.

To cancel the check-out process, select the Reset/Clear button. After confirming you wish to reset the

check-out process, the system will clear the check-out list without saving it.
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To check in an individual asset, select the Check In by Asset tab. The screen will change as indicated
below.

& CheckIn/Out ==

‘C‘H SavelFrint‘ | @ Reset ] Clear ‘E Remove ltem

Check Out (F1) Check In by Asset (F2) Check In by Person / Location (F3)

Asset Barcode: | D Description:

GCheckin ‘ IH e

From Person /

Barcode Description Due Return Condition Facility Location Bin Qty Status

Jser Name: User, Admin Database: localhostiwin_is

To check an asset into storage, scan the asset barcode or enter the asset barcode and then press the
Enter Key on the keyboard. If the asset is a binned item, a box will appear to enter the quantity being
checked in. The check in information will be entered in the list. Condition, Facility, and Storage
Location may be changed. Select the column you wish to change, select the Enter key and pick the new
Condition, Facility, or Storage Location from the list.

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected, the system will ask if you wish to print the check in report.
The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.

To check in assets assigned to either a container, an employee, or a location select the Check In by
Container / Person / Location tab. The screen will change as indicated below.
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Check In

H s Cpysowipin | @) Rooti Coo - Sp——

Check Out F1)

Chick Inby Asst F2)

Check In by Parson I Location [F3)

To check an asset into storage, first

select or scan the container,

Locain @ Emplyes

employee or location barcode the
items are being returned from. A
listing of all items checked out to

Chk Barcode Dosciption [ Rolum | Condition___ Faciity Bin Oty Statis

the container/employee/location
will be displayed. You can then click
the check box for each line item
being returned. Binned item
guantities can also be changed in
the grid if desired.

A Check All option box will check or uncheck all checkboxes for each line item listed. Alternately, you
can scan individual asset barcodes to check the checkbox. You can also change the status to Lost or
Broken for any items checked. The change occurs on Save. If someone returns multiple assets but has
lost others, check-in the returned items first and Save. Then, do a new check-in for the individual and
confirm that the remaining items listed are lost. Check All and Change Status to Lost then Save. The
COPY ROW function allows you to split up binned items being returned so that alternate locations can
be assigned. Verify the QUANTITY is correct before saving!

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all assets have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected the system will ask if you wish to print the check in report.
The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Each report has a different set of Report Filters that the

Reports

user can select to create the report results they desire.

D Print Repert

Select the report of interest and the report filters will

Select Report ReportFiters

appear on the right portion of the screen.

Some reports have an Ignore Due Date greater than a

Tool Ass gnmen:
Tool Ass gnmen: by

specified date. This is useful if some assets are checked

ess, Type end Locatcn

Tool Ass gnmen: by Conaner
o

out to a location or employee over a long period of time,
and you do not want these assets to appear on monthly
reports.

u
Tool Depvecaton oy Class ard Type
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When the filters are set, the user then selects the Print Report button. A print preview screen will be
displayed from which the report may be printed, saved as a PDF or Email(ed) (only if Microsoft Outlook
is used).

The Asset Assignment and History Reports (see screen above) give you the ability to Auto E-Mail the
report when desired. Select “Email Report(s)” so that each person gets their own email with their
information. Only employees with an email address record will receive their email report.

If desired, GigaTrak can provide custom reports at your request. These reports will be quoted
separately and automatically added to the Select Report listing when installed.

GigaTrak provides 90-days of telephone support for ATS from the date of purchase. GigaTrak will
advise on installation issues but the customer is responsible for network and SQL Server installation.
Our hours are 9am to 5pm central time Monday through Friday. During this time you are entitled to
any updates or new releases issued by GigaTrak. By purchasing an extended support one, two or three
year agreement, these services are extended. Onsite support is available at additional cost. Please call
262-657-5500 extension 2 with any questions.
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